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Preface 

This guide is aimed at the novice computer users who want to install Parallels Workstation in 
their Windows primary operating system and create one or more virtual machines to run 
different versions of Windows as the guest operating systems. This guide provides all the 
necessary information for installing Parallels Workstation and creating new virtual machines. It 
also gives detailed procedures of Windows XP and Windows Vista installation. 
 

 



 

C H A P T E R  2  

Installing Parallels Workstation 

In this chapter you’ll learn how to install Parallels Workstation. 

Preparing for installation 

If you purchased the boxed edition of Parallels Workstation: 

 Insert the CD and keep the CD sleeve with the activation key handy. 

If you purchased the program from Parallels Online store 
(http://www.parallels.com/en/buyonline), or downloaded a trial version, make sure that you 
have a permanent or trial activation key, and: 

 Locate the downloaded self-extracting Parallels-Wst-2.2.xxxx-Win.exe file and 
double-click it. 

Step-by-Step Installation 

Note. You must have Power User or Administrator rights to install Parallels Workstation in a 
Windows operating system. 

1 In the Welcome to Parallels Workstation Setup Program dialog box click Next. 

 
2 In the License Agreement dialog box use either the PgDn key or the Down Arrow ↓ key to 

read the licence agreement. Select the I accept the terms of the license agreement option.  

 

http://www.parallels.com/en/buyonline
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You may print the license agreement for your records using the Print button. Click Next to 
proceed with the installation. 

 
3 If you are re-installing or updating Parallels Workstation, you will not see the User 

Registration dialog box. Proceed to the next Step. 

If you have a permanent activation key, register to receive news about Parallels products or 
skip the registration by clicking the Skip registration button. 

If you prefer to register on the Parallels web site, click the Register on site button. 

To buy Parallels Workstation and receive a permanent activation key, use the Buy button. 
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In the User Registration dialog box enter your contact information necessary for sending you 
a trial activation key. Please enter your E-mail and User name. The Company name field is 
optional. Check I want to receive news from Parallels to my E-mail if you want to be informed 
about new Parallels products. You will receive a free trial activation key by e-mail. 

 
4 In the Customer Information window, activate your copy of Parallels Workstation. To do 

this, enter your Activation key by typing it directly into the field or by using the copy-paste 
method. The User Name and Company Name fields are optional. To skip this step, click the 
Activate later button. You can activate the product when it is installed by choosing Activate 
Product from the Help menu. 

Click the Register on site button to register at the Parallels web site in order to get a trial 
activation key. 
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Click the Buy button to purchase a permanent activation key at the Parallels Online Store. 
Click Next. 

 
5 In the Choose Destination Location dialog box specify a folder where Parallels Workstation 

will be installed. To install it to the folder other than the default one, click the Change 
button. Note that Parallels Workstation must be installed only on the boot disk. 

 
Click Next. 
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6 In the Select Program Folder dialog box specify the name for the Parallels Workstation 
folder in the Programs list of the Windows Start menu. 

 
By default, the folder name is Parallels. However, you may choose one of the existing 
folders or type the name directly into the field. 

Click Next. 
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7 In the Select shortcuts dialog box, specify what shortcuts should be created for Parallels 
Workstation.  (The Windows Quick Launch panel is located on the taskbar.) 

 
Click Next. 

8 In the Ready to Install the Program dialog box, click Install to start the Parallels Workstation 
installation or click the Back button to return to the previous steps. 

 

 



 

 Installing Parallels Workstation 11 
 

9 If your Windows primary operating system is configured to warn you every time an 
unsigned driver is installed, you will see the following message: 

 
Click OK to disable the unsigned driver warnings during Parallels Workstation installation. 
They will be re-enabled later when the installation is complete. 

If your system is configured to block the unsigned drivers installation, you will receive 
similar message prompting you to allow the installation of these drivers. Click OK. 
Otherwise, Parallels Workstation can not be installed at all.  

10 You can see the installation progress shown in the Setup Status dialog box. 

11 When Parallels Workstation is installed, the Setup displays the following dialog box: 

 
To open the Readme file in Notepad select the I want to view Readme file option.  

To complete the installation, click Finish. 
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Starting Parallels Workstation 

To start Parallels Workstation 
 In the Windows Start menu, select Programs --> <Parallels Folder Name> --> Parallels 

Workstation  where <Parallels Folder Name> is the folder in the Windows Start menu that 
you chosen for Parallels Workstation during the installation.  

 You may also start Parallels Workstation by double-clicking its icon on the desktop, by 
single-clicking its shortcut in the Start menu, or by single-clicking its icon in the Quick 
Launch panel, if you have added the corresponding shortcuts during the installation. 

To exit Parallels Workstation 
 Choose Exit from the File menu 
 Click the Close button on the title bar of the Parallels Workstation window. 
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Creating a Virtual Machine 

The process of creating a ready-to-use virtual machine includes the following steps: 

 Creating a virtual machine configuration, that is the virtual machine with a set of virtual 
hardware. 

 Installing an operating system in the virtual machine; such operating system is called the 
guest operating system. You must have a full (not OEM) version of the operating system 
you wish to install. 

 Installing Parallels Tools. Available for both Windows XP and Vista. 

The procedure of creating virtual machines is generally the same in all the supported primary 
operating systems. 

An easiest way to create a virtual machine configuration 

Here we will describe how to create a virtual machine configuration for further installation of 
Windows Vista or Windows XP as a guest OS.  

1 When you start Parallels Workstation for the first time, the Welcome window of New 
Virtual Machine Wizard appears: 
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2 Click the Next button in the New Virtual Machine Wizard window. 

 
3 In the next dialog box make sure that the Create a typical VM option, is selected. If you are 

new to virtualization, do not select another option. The easiest way of creating a virtual 
machine is to create a typical one. Click Next. 
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4 In the next dialog, specify the guest operating system you are going to install in the virtual 
machine: Windows family from the first pop-up menu and the version  (XP or Vista) from 
the second one. Click Next. 

 
Specify a name for your virtual machine. By default, the wizard will name the virtual 
machine after the guest operating system you've selected. The name doesn’t really matter 
unless you plan to create several VMs running the same operating system; in that case, 
you’ll need to give them distinct names (“Windows XP for Games” and “Windows XP 
for Work”, for example).  

You can also specify the folder to store your virtual machine files. By default, the virtual 
machine is placed into your personal folder. Click Finish to create the virtual machine. 

5 When the wizard displays the following message, click Yes to let Parallels Workstation 
create a new folder for the virtual machine. 

 
The virtual machine is created, but it is blank. You have to install the specified guest OS.  
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Installing Windows XP 

To install the Windows XP guest operating system in your virtual machine, follow these steps: 

1 Insert the Windows XP installation CD or DVD disc into the CD/DVD-ROM drive of your 
computer. 

2 Click the Power On  button to start the virtual machine. The Property Page transforms 
to the Console window. 

3 The Installation starts, and the Welcome to Setup screen appears. 

 
Both your physical computer and the virtual machine emulated in it use the same mouse and 
keyboard devices. To use your keyboard and mouse inside the virtual machine, click 
anywhere inside the virtual machine's Console window. 

Note. To release the keyboard and mouse input back for using them in the primary OS press 
Ctrl+Alt at any time. 

After this press Enter on your keyboard. 
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4 The license agreement is displayed on the screen. To scroll it down press the Page Down 
key. To agree press F8. 

 
5 In the lower part of the following screen, the Setup displays the list of hard disks and 

partitions available in the virtual machine. For a new virtual machine this list contains only 
one item: the unpartitioned space. Press Enter to create a partition on the unpartitioned 
space. 
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6 On the next screen choose the file system for that new partition that will be the system 
volume in your virtual machine. Select the type of file system and mode of formatting and 
press Enter. Formatting to NTFS is recommended. 

 
7 The virtual machine will restart automatically. The text stage of the installation has 

completed. During the next (GUI) stage, dialog boxes will be used.  

8 Specify your Regional and Language Options and click Next. 
9 Enter the license key and click Next. 
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10 On the next several screens you will be prompted to enter the computer name and 
administrator password, select your date and time zone. When prompted to specify your 
network settings, select Typical. 

11 Next, you should specify whether your computer will be a member of a domain. If you are 
creating a virtual machine for running it in corporate environment, ask the system 
administrator whether you should specify the domain. Otherwise, choose the first option to 
make your virtual machine a member of the workgroup. 

 
12 After that, Setup adjusts the Display Settings for better image quality. 
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13 In the Help protect my PC screen indicate whether you want to turn on the Automatic 
Updating feature. It is recommended to enable the Automatic Updates feature. 

 
14 On the next screen, choose the way your computer will be connected to the Internet.  Select 

Yes. 
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15 If you want to register with Microsoft select Yes on the following screen. 

 
16 When prompted, create user accounts for each person who will use this virtual machine. 
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The installation of Windows XP is complete. But there is one more operation the you should 
perform before you can use the virtual machine - install Parallels Tools. 
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Installing Windows Vista 

Only the following editions of Windows Vista are supported as guest OSes in Parallels virtual 
machines: Ultimate, Enterprise, or Business. 

Insert the installation CD/DVD disc into the appropriate drive of your computer. 

The Windows Vista installation starts as soon as you click the Power On button. The installation 
wizard guides you through the following steps: 

1 Once Windows loads the necessary files, you will be prompted to set the language and other 
national preferences. Click Next to proceed. 
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2 On the next screen click Install now. 

 
3 Enter your product key. Click Next. 
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4 Read the license terms and select I accept the license terms if you agree. Click Next. 

 
5 Click the Custom installation option. 
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6 On the next screen select the unpartitioned hard disk and click Next; all the space will be 
allocated for one partition. If you want to create several partitions, click Driver options 
(advanced) and partition the virtual hard disk specifying the size for each partition. When 
the disk is partitioned, click Next. 
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7 Once all the necessary files are copied, you will be prompted to enter a user name. In case 
you want to protect your Windows by a password you will have to enter it twice and provide 
a hint that can help you in case you forget the password. Click Next. 

 
8 On the next screen choose the way of enhancing your Windows security. Click the desired 

option. 
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9 On the next screen set the time and date. If everything is correct, click Next. 

 
10 On the next screen click Start. Enter the password, if prompted. 

When the installation is complete, you can eject your installation CD or DVD, or disconnect the 
disc image. 
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Installing Parallels Tools 

When the installation of Windows XP is complete, you can start working with your virtual 
machine.  

But consider installing Parallels Tools first. After installation of Parallels Tools you don't have 
to press the special key combination (Alt+Enter) to release your mouse and keyboard input 
to the primary operating system each time you want to switch to it or its applications - just click 
anywhere outside the Guest OS window to switch. Parallels Tools will also let you use shred 
folders to transfer the data between the guest and the primary OSes. The Tools will also enhance 
the performance of your virtual machine in many other aspects. 

To install Parallels Tools 
1 Choose Install Parallels Tools from the Parallels Workstation VM menu. 

2 When you see this message, click OK. 

 
3 In the Welcome window of the Parallels Tools Setup wizard click Next. 
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4 In the Choose Destination Location window click Next to install Parallels Tools in the default 
folder. 

5 In the Setup Type window make sure that the complete type of setup is selected. Click 
Next. 

 
6 In the Select Program Folder window click Next. The default folder will be used. 

7 The Check Setup Information window displays the options selected. Click Next to begin the 
installation. 

8 Click OK in the unsigned drivers warning dialog box. 
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9 After the wizard finishes to copy the files, click Finish in the Installation Completed window. 

 
After the restart the virtual machine will be ready for work. 
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Starting, Stopping and Resetting a 
Virtual Machine 

Starting a Virtual Machine 

When you start Parallels Workstation, the last used virtual machine will be opened by default.  

To start up the virtual machine just click the Power On  button on the Parallels Workstation 
toolbar (or choose VM -> Power On).  

The virtual machine switches on, and you can see the booting of the guest OS in the Parallels 
Workstation window.  

Stopping a Virtual Machine 

The same rules are applied to turning off /resetting a virtual machine as to turning off /resetting 
a physical computer.  

First, shut down a guest operating system by using the guest OS "shut down" command (such as 
Start -> Shut Down or Start ->Turn off Computer in Windows). It is STRONGLY 
RECOMMENDED that you shut down the virtual machine in this way to ensure safety of your 
data. Then close the Parallels Workstation window. 

Only if you are unable to shut down the guest OS this way, you may use the Parallels 
Workstation controls to stop it. To stop a virtual machine anyway, do one of the following: 

 Click the Power Off   button on the Parallels Workstation toolbar. 
 Select Power Off from the VM menu. 

The virtual machine will be stopped immediately. 

Resetting a Virtual Machine 

First, restart a guest operating system by using the guest OS "restart" command (such as Start -> 
Shut Down -> Restart or Start -> Turn off Computer -> Restart in Windows). It is STRONGLY 
RECOMMENDED that you restart the machine in this way to ensure safety of your data.  

Only if you are unable to restart the guest OS this way, you may use the Parallels Workstation 
controls to stop or to reset it. 

To reset a virtual machine, do one of the following : 

 Click the Reset button on the Parallels Workstation toolbar. 
 Select Reset from the VM menu.  
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 Press Ctrl+Alt+Insert while the keyboard input is captured inside a virtual machine 
window. 
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Getting to Know the Interface 

When the virtual machine is created, you will see the Parallels Workstation main window 
similar to that one below.  

 

 



 

 Getting to Know the Interface 35 
 

The Parallels Workstation main window displays the Property Page of the just created virtual 
machine and has the title bar, menu and toolbar. 

Title bar 

The title bar displays the title of the virtual machine, below the title you can see the Parallels 
Workstation menu.  

Menu 

Menu for Parallels Workstation contains all the controls available for Parallels Workstation and 
its virtual machines.  

Toolbar  

Toolbar (on this picture, shown to the right) has the following buttons: 

  - Start the virtual machine. 

  - Stop the virtual machine. 

  - Reset a virtual machine.  

  - Pause the virtual machine. 

  - Switch the virtual machine to the full screen mode and back to window mode.  

  - Switch the main window to Property Page view. 

  - Switch the main window to Console or Guest OS window view. 

Most of the toolbar buttons become enabled when you start the virtual machine. When the 

virtual machine is stopped, only the Power On  button is enabled. 

If you click a toolbar button it becomes visibly pressed.  

Property Page 

The virtual machine's Property Page lists the virtual machine hardware and some of the options. 

The Property Page contains:  

 The Configuration list (in the upper part of the Page) that displays the virtual machine name, 
the location of the configuration file, and general VM settings. 

 The Resources list ( in the middle part) that shows all the devices connected to the virtual 
machine and their options. 

 The command buttons ( in the lower part of the window). 
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What to Do Next 

If your primary operating system is connected to the Internet, your new virtual machine can 
share this connection by using the Shared Networking (NAT)  that is selected as a default 
option for a new virtual machine. 

The next thing you probably will do is setting up shared folders. A shared folder is a folder in 
your primary operating system that is visible to your virtual machine. To learn more about using 
shared folders, read the Using Shared Folders topic in Managing Virtual Machines chapter. To 
open this chapter, choose Contents from the Help menu. 

Then you can install your favorite Windows applications. For software installation you may use 
various types of media: 

 CD/DVD-ROMs; 
 ISO images of CD/DVD-ROMs made with Parallels Image Tools or third-party imaging 

products (use the Devices menu to connect or disconnect ISO images from CD/DVD-ROM 
drive at runtime); 

 installation files placed into shared folders; 
 local network resources or the Internet if your computer is connected to it. 

Tips 
 To change the configuration of the virtual machine shut down the guest OS. On the Property 

Page of the virtual machine click the Configuration link to open Configuration Editor or 
choose Edit Configuration from the File menu. Add or remove devices and edit their options. 

 To set the virtual machine's startup options choose Preferences from the Edit menu. 
 To switch to full screen mode and back press Alt+Enter. 
 The Windows primary OS will intercept the Ctrl+Alt+Del key combination pressed in 

the guest OS. To emulate pressing  Ctrl+Alt+Del in the guest OS choose the Send 
Ctrl+Alt+Del command from the VM menu or press Ctrl+Alt+Ins. 
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